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Worum geht es?
Praktisch alle grösseren Gemeinden der Schweiz verfügen über mehrere Primarschulhäuser. Jedes Jahr müssen die Erstklässler auf eines der Schulhäuser zugeteilt werden.
Für die betroffenen Kinder und deren Eltern spielt das erste Schulhaus oft eine wichtige Rolle, ist doch der Schulweg ein bedeutender Erfahrungsraum für die kleinen Erstklässlerinnen und Erstklässler.
Die Länge des Schulweges ist ein zentrales Kriterium für eine Zuteilung, aber auch die Gefährlichkeit von Strassen ist sicher ein beachtenswerter Punkt.
Mit GIS kann man elegant alle räumlichen Kriterien (Schulweg, Strassengefährlichkeit u. ä.) abklären und eine Zuteilungskarte erstellen, auf der dann weitere Detailabklärungen (z.B. Geschwister, Anzahl Schüler usw.) basieren können.
Noch praktischer wird es, wenn man die Adressen der Kinder kennt und deren Wohnkoordinaten. Dann kann man eine räumliche Dichteverteilungskarte erstellen, in der leicht ersichtlich wird, welche Gebiete wie viele Kinder aufweist.
In dieser Aufgabe beschränken wir uns auf eine Zuteilungskarte, welche Distanz und Gefährlichkeit einzelner Strassen berücksichtigt.


Die Daten
Um diese Analyse mit GIS vorzunehmen, braucht es räumliche Informationen über die betreffende Region. Man muss die Gebäude und das Strassennetz kennen. Diese Informationen müssen in digitaler Form - das heisst in Zahlen - vorliegen. 
Über die Landnutzung führen in der Regel die Gemeinden und der Kanton Buch. Sie verwalten die aktuellen Zonenpläne (Bauzone, Landwirtschaftszone, Wohnzone usw.). Dabei handelt es sich um gezeichnete Karten und Pläne, welche heute oft in digitaler Form erhältlich sind. Im Aargau sind die meisten dieser Karten digitalisiert und werden vom AGIS (Aargauische Geographische Informationsstelle) verwaltet.
Die folgenden Datensätze stehen zur Verfügung:
· Strassennetz Kanton Aargau (Linien): xstr_458_20040525
· Gemeindegrenzen Kanton Aargau (Polygone): gemg_214_20020828
· Gebäudekarte Kanton Aargau (Polygone): wgeb_189_20040514
· Digitales Höhenmodell: mmgr_20011228 (Rasterbild)


Die Fragestellung
Wir wollen herausfinden, welches Schulhaus für welches Quartier zuständig ist. Dabei berücksichtigen wir folgende Kriterien:
· Länge (Dauer) des Schulweges (Weg und Zeit)
· Gefährlichkeit von Strassen


Grundsätzliches
In diese Übung werden Sie folgende GIS-Techniken kennenlernen:
· Eingrenzung von Raster und Vektordaten auf eine Region
· Umwandeln von Vektor in Rasterdaten
· Gewichtung des Kriteriums Strassengefährlichkeit vornehmen
· Rasterdaten neu klassifizieren (Strassenlinien in Strassenraster)
· Einzelne Objekte (Häuser) identifizieren und auswählen


Die Lösungschritte mit ArcGiS

Übersicht: 3D Ansicht der Region Baden-Wettingen (Arcscene)
Zuerst wollen wir uns eine Übersicht über das Gebiet verschaffen. ArcGis bietet mit dem Modul ArcScene die Möglichkeit dreidimensionale Karten einer Oberfläche zu erstellen. Dazu brauchen wir ein digitales Höhenmodell, welches die Höhenangaben des Gebietes liefert. Wir überlagern diese Reliefdaten mit der Landnutzung (drape image) und erhalten eine 3D-Darstellung der Oberfläche, auf der die Landnutzung sichtbar wird. Die neue Karte zeigt uns die räumliche Verteilung der Waldgebiete, Seen, Dörfer usw..


1. Ausschnitte für unsere Region
Die Karten vom AGIS umfassen in der Regel den gesamten Kanton Aargau. Wir werden zuerst alle Datensätze auf einen Ausschnitt für unsere Region reduzieren.

a) Digitale Höhenkarte für Wettingen ausschneiden
Add Layer > mmgr_20011228 (im Ordner 1060_DHM25-Matrixmodell). Es handelt sich um das digitale Höhenmodell des Kantons Aargau in einer Auflösung von 25 Meter.
Damit wir die auszuschneidende Region besser abgrenzen können, legen wir die Gemeindegrenzen von Wettingen über das digitale Höhenmodell. -> add layer -> gemg_214_20020828 (im Ordner 214_gemeinden).
Mit Lupe und Hand arrangieren wir die Anzeige so, dass die Gemeindegrenzen von Wettingen gerade Platz in der Anzeige finden.
Lassen Sie sich die Symbolleiste Spatial Analyst anzeigen. Dort Optionen > Ausdehnung > gleich wie Anzeige > OK.
Spatial Analyst > Raster berechnen > auf die angezeigte Layer (mmgr_20011228) doppelklicken, so dass sie in der unteren Anzeige erscheint. Auswerten.
[image: ][image: ]
Der berechnete Ausschnitt erscheint nun in der Anzeige „Berechnung“. Wir klicken mit der rechten Maustaste auf Berechnung und wählen „permanente Darstellung“. 
[image: ]
Wir speichern die Datei unter einem sinnvollen Namen.

b) Gemeindegrenze Wettingen auswählen (Features auswählen)[image: Featuresauswählen]
Auf das „Features auswählen“ Werkzeug klicken, mit dem Pfeil das Polygon der Gemeindegrenze von Wettingen anklicken. Bei Bedarf Umschalten auf Auswahl > Interaktive Auswahlmethode > „Aus aktueller Auswahl entfernen“. 
Die ausgewählte Grenze erscheint in hellblauer Farbe.
[image: ]


c) Neue Layer Gemeindegrenze Wettingen erzeugen
Rechte Maustaste auf Layer gemg_214_20020828 > Daten exportieren > Ausgewählte Features > Speicherort und Namen angeben. Die Layer gemg_214_20020828 kann nun entfernt werden.
[image: ]

d) Strassen und Gebäude innerhalb von Wettingen auswählen
Da wir die Gemeindegrenze von Wettingen als Datei (Vektordatei, Polygone) gespeichert haben, können wir alle „Features“(z.B. Gebäude (Polygone), Strassen (Linien)) die innerhalb der Gemeindegrenzen liegen auswählen.
Die Funktion „Lagebezogene Auswahl“ bietet diese Möglichkeit. Auswahl > Lagebezogene Auswahl > Menü so ausfüllen wie in der Darstellung.
	
[image: ]

e) Strassenkarte und Gebäudekarte von Wettingen erzeugen
Die ausgewählten Strassen und Gebäude, welche nun in hellblauer Farbe erscheinen exportieren wir und speichern sie unter sinnvollen Namen. Rechte Maustaste auf Layer > Daten exportieren > Ausgewählte Features > Speicherort und Namen angeben. 
Die Layer wgeb_189_20040514 kann nun entfernt werden.

f) Schummerungsanzeige
Für eine dreidimensional wirkende Anzeige können wir der digitalen Karte (Raster) eine Schummerung hinzufügen. Spatial Analyst > Oberfläche > Schummerung. Füllen Sie das Menü so aus wie dargestellt.
[image: ]






2. Strassen
a) Strassenklassen anzeigen lassen
Wir versuchen nun die Strassen einzustufen in für die Kinder gefährliche und weniger gefährliche. Die Strassenkarte des Kantons und unseres Wettingerausschnitts beinhaltet bereits eine Strassenklassifikation. Die Spalte „Objectval“ enthält diese Angaben.
Rechtsklick auf die Layer mit den Strassen von Wettingen und die Karteikarte „Symbologie“ anwählen. Kategorien > Einzelwerte > Wertefeld Objectval > alle Werte anzeigen.
Nun erscheinen wie unten abgebildet alle Strassenklassen. OK.

[image: ]

b) Autobahnen
Die Autobahnen sind für unsere Karte irrelvant, weil es sie als Fussgängerwege gar nicht infrage kommen. Wir können also alle Autobahnen löschen.
A_Zufahrt, Autobahn und Ein_Ausf sind alles Autobahnteile, welche nicht benötigt werden. Wählen Sie ein dickes rotes Liniensymbol für diese drei Kategorien, so dass diese in der Karte gut sichtbar werden.
Auf das „Features auswählen“ Werkzeug klicken[image: Featuresauswählen], mit dem Pfeil alle roten Autobahnstücke anklicken, so dass diese hellblau erscheinen.
[image: ]
Rechtsklick auf die Layer mit den Strassen von Wettingen > Auswahl > Auswahl umkehren. Nun sind alle Strassen mit Ausnahme der Autobahnabschnitte ausgewählt und wir können eine neue Karte ohne Autobahnen erzeugen.
Rechtsklick auf die Layer > Daten > Daten exportieren. Speichern Sie die neue Strassenkarte und lassen Sie sich diese anzeigen.

c) Gefährliche Strassen Klasse 1, 2
Auf den Strassen der Klassen 1 und 2 wird der Durchgangsverkehr durch Wettingen abgewickelt. Es handelt sich also um relativ stark befahrene Strassen, welche für die Kinder als eher gefährlich einzustufen sind. Alle übrigen Strassen sind wohl eher schwach befahren und als weniger gefährlich einzustufen.
Lassen Sie sich die Strassen der Klasse 1 und 2 als dicke schwarze Linien anzeigen und sie werden erkennen, dass es sich tatsächlich um Durchgangsstrassen handelt.


3. Schulwegkosten
Wir möchten für die Zuteilung berücksichtigen, dass es darauf ankommt, auf welchen Wegen das Kind unterwegs ist. Die Schulzuteilung soll nicht nur den kürzesten Weg, sondern auch die Gefährlichkeit Schulweges berücksichtigen. Wenn die zugeteilte Schule sehr nahe liegt, der Weg dahin jedoch über eine gefährliche Strasse führt, ist es sinnvoller einen längeren aber sichereren Schulweg zu haben.
GIS benützt dazu eine Zuteilung nach „Kostengewichtung“. Übertragen auf unser Beispiel kann man die Kosten für den Schulweg in „Distanzkosten“ (je weiter weg desto teurer) und „Gefährlichkeitskosten“ (je gefährlicher desto teurer) unterteilen. Wenn das Gelände einigermassen eben ist, entsprechen die Distanzkosten dem Zeitaufwand für den Schulweg (je weiter weg desto länger hat das Kind).
–> Kosten für den Schulweg = Zeitaufwand (= Distanz wenn eben) + Gefährlichkeit

Wir müssen zuerst einen Kostenraster erstellen, bevor wir das Programm eine Zuteilung machen lassen. Der Kostenraster gibt an, wo der Schulweg für das Kind besonders „günstig“ ist – günstig in Bezug auf die Distanz und die Gefährlichkeit.
Bei der Erstellung des Kostenrasters liegt es an uns, zu entscheiden, wie stark wir die Gefährlichkeit einschätzen – mit unserer Einschätzung zur Gefährlichkeit der Strassenbestimmen wir letztlich den Schulweg der Kinder.
Am günstigsten ist es natürlich auf kleinen Strassen, am ungünstigsten dort wo es gar keine Strassen gibt. Wir müssen nun diese Einschätzungen in Zahlenwerte fassen. Z.B. so:
· Keine Strassen = sehr ungünstig = 10
· stark befahrene Strassen = ungünstig = 2
· wenig befahrene Strassen = günstig = 1

a) Strassenkarte (Vektor Linien) in Rasterkarte umwandeln
Zur Erstellung des Kostenrasters brauchen wir – wie der Name sagt – Rasterdaten. Wir müssen zuerst die Strassenkarte in eine Rasterkarte umwandeln und dabei den Pixeln für die Strassen sinnvolle Werte zuordnen.
Spatial Analyst > Konvertieren > Features zu Raster, füllen Sie die Maske so aus wie in der Abbildung (sinngemässer Speicherplatz angeben).
[image: ] [image: ]

b) Strassenraster reklassifizieren
Wir haben nun eine Rasterkarte der Strassen von Wettingen erzeugt. Die Legende zeigt die verschiedenen Strassen, wobei jede Strasse einen anderen Wert erhält. Die ersten zwei Strassensignaturen sind die Strassen der Klasse 1 und 2.
Wir müssen diese Rasterkarte so verändern, dass nur noch die Werte 10 (für No Data), 2 (für die Strassen der Klassen 1, 2) und 1 für alle übrigen Strassen vorkommen.
Tools > Spatial Analyst Tools > Reclass > Reclassify. Füllen Sie das Dialogfeld so aus wie in der Abbildung.
[image: ]
Das Resultat ist unser Kostenraster, welcher noch drei Werte enthält (1, 2, 10).


4. Primarschulhäuser
Für die Zuteilung der Kinder brauchen wir die Wettinger Primarschulhäuser, d.h. wir müssen sie in der Gebäudekarte identifizieren. Dazu brauchen wir eine Karte der Gemeinde Wettingen, die Primarschulen und deren Adressen.

Primarschulen in Wettingen sind:
· Dorf
· Altenburg
· Margeläcker

a) Primarschulhäuser auswählen
Nachdem wir die Gebäude der Schulhäuser gefunden haben, wählen wir sie mir dem „Features auswählen“ Werkzeug[image: Featuresauswählen] aus (ein Gebäude pro Schulhauskomplex).
(Umschalt + linker Mausklick = zu den schon ausgewählten hinzufügen). Die ausgewählten Primarschulhäuser erscheinen in hellblauem Rahmen.

b) Karte der Primarschulhäuser erzeugen
Rechter Mausklick auf die Gebäudekarte mit den ausgewählten Primarschulhäusern > Daten > Daten exportieren. Füllen Sie das Dialogfeld so aus wie in der Abbildung (sinngemässer Speicherort anwählen) und lassen Sie sich die produzierte Karte als Layer hinzufügen.
[image: ] [image: ]

c) Primarschulhäuser beschriften
Die neue Karte enthält somit nur noch drei Gebäude. Diese werden in der Attribut-Tabelle sichtbar, dort sind nur noch drei Zeilen vorhanden. Wir werden nun eine weitere Spalte hinzufügen und dort die Namen der Schulhäuser notieren, damit diese dann in der Karte angezeigt werden können.
Rechtsklick auf die Layer mit den Schulhausgebäuden > Attribut-Tabelle > Optionen > Feld hinzufügen > Dialogfeld ausfüllen wie in der Abbildung.
[image: ] [image: ]

[image: ]
Wir wollen in die neue Spalte die Namen der Schulhäuser schreiben. Dazu müssen wir zuerst den Editiermodus starten. Ansicht > Werkzeugleisten > Editor > Bearbeitung starten
[image: ]
Rechtsklick auf die Layer mit den Schulhausgebäuden > Attribut-Tabelle > Namen der Schulhäuser in die entsprechenden Felder einfüllen. Editor > Bearbeitung beenden.


5. Zuteilungkarte
Wir haben nun alle Vorbereitungen abgeschlossen und können das Programm eine Zuteilung vornehmen lassen.
a) Ausdehnung der Analyse
Zuerst definieren wir die räumliche Ausdehnung, d.h. die Fläche auf welcher die Analyse stattfinden soll.
Spatial Analyst > Optionen > Ausdehnung > gleich wie Layer Gemeindegrenzen
[image: ]

b) Kostengewichtete Zuteilung
Nun berechnen wir eine Zuteilung zu den Schulhäusern unter Berücksichtigung unseres Kostenrasters (beinhaltet die Gefährlichkeit der Strassen und "Unwegsamkeit").
Spatial > Analyst > Entfernung > Kostengewichtet
Füllen Sie das Dialogfeld so aus wie in der Abbildung.
[image: ] [image: ]
Wir erhalten nun zwei neue Karten, eine auf der die "Wegkosten" für die Kinder dargestellt ist (Kostengewichtete Entfernung) und eine zweite, welche die Zuteilung zu den Schulhäusern zeigt (Kostengewichtete Allokation).

Schluss: Anzeige der Resultate
Wir präsentieren unsere Lösung dem Kunden mit einer anschaulichen Karte:
Als Hintergrund eignet sich z.B. die Reliefdarstellung mit der Schummerung. Weiter brauen wir die Zuteilung zu den Schulhäusern, die Strassen von Wettingen und die Schulhäuser und ev. auch die Karte der Wegkosten.
Wählen Sie eine geeignete Reihenfolge der Layer und sinnvolle Transparenzen.

Ein Lösungsvorschlag:

[image: ]
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Schema der Lösungsschritte (ohne Präsentation der Ergebnisse)

1. Ausschnitte für die Region
a) Rasterdaten (digitales Höhenmodell)	
Spatial Analyst>Optionen
Ausdehnung>Anzeige
dhm25
Raster berechnen
dhm25wett
dhm25wett (temp)
Permanente Darstellung




b) Vektordaten (Gemeindegrenze, Strassennetz, Primarschulhäuser)
gemg_214
Daten exportieren
Features Auswählen
Ausgewählte  Features

gemg_214




2. Strassen (Autobahnen entfernen)
Features Auswählen
Daten exportieren
strasswett

Auswahl umkehren

xstrassawett





3. Schulwegkosten
strasswett

Features zu Raster
Reklassifikation
strasswettraster

strasswett1-2-10



4. Primarschulhäuser
Ausgewählte  Features
Daten exportieren
Features Auswählen

primarwett


gebäudewett


5. Zuteilungskarte erstellen
zuprimwett
strasswett1-2-10
kowegwett
primarwett
Entfernung Kostengew.

image1.png
Dotei Bearbsiten Ansicht Einfigen Auswahl Werkzeuge Fenster Hife

DEed&

8% =

4 Il

Somm
o
i

= B redass_gsm 2

-
= B redass _xeist
o
-
= B redass_aspel
o
-
= B redass _siopt
o
-

T3 Arerodbox
@ 30 Anslyst Tooks
) @ Analyss Tooks

@ Cartography Tools
@ Conversion Tocs
@ Data Management Tools
@ Geocoding Tools
@ Linear Referencing Tocs
= @ Spatial Anlyat Tocks

bttt

« & Densty

= & Ditence

= & Exraction

= & Generalzation

& Grounduater

% & Hydrobooy

= g Interpolaion

= & Local

% & Mep Algcbro

« & math

= & Mukiveriste

% & Neighborhood

& Overlay

“ g Raster Creation

= & Redass

= & sufece

« & zonal

) SpatialStatstcs Tools

Areige [Tuste] Auswanl]

Favorton [index | Suchen]

zechnen v | R

rechnung zwischen Rast

spatial Analyst
Spatia analyst ~.

Entfernung
Dichtz.
Interpolieren 2u Raster
berflachenanalyse
Zelenstatist.
Nchbarschaftsstatst.
Zonale Statitk.

Reklassfizeren.

Konvertisren

Optionen,

Layer: [reclass_siop1 =~

O~ A~ = [aaa

Layern durchfohren





image2.png
Raster berechnen I

Laper
|72 e s af ofam
72 I T A S S (1
1| 2| 3| <f | %
< 3 0 || net

[mngy_20011228]

e ke s I [ e | 531





image3.png
Kopieren
Hoct ¥ Entfernen

Ned B Attrbut-Tabell offnen

M2 yerbindungen und Beziehungen
et
Hodl @& AF Layer zoomen

ALf Raster-Aufissung zgomen

Sichtbarer Mafistabsbereich

Ned

Daten

als Layer-Datei speichern...





image4.jpeg




image5.png
auswahl Werkeeuge Eenster Hife

I ——
8 Lagebezocene Ausneh

L =1

8 uf skt Festures zoomen
2 otk

Auswshibare Layer einstelen.

[ Feature-Auswahl aufheben

14| teue Auswahi erstelen

Optionen. 2ur sktuellen Auswahi hinzufigen

fus aktuellr Auswahi entfernen
Aus aktueller Auswahl auswahlen




image6.png
[oema_zuszoceeezel LU s
O B gopieren

Berer X ertfernen
wer
Hocl ] Attrbut-Tabell offnen
Verbindungen und Bezichungen »

G Auf Layer zoomen

Ned

Sichtbarer Mafistabsbereich »
Symbolebenen verwenden

ausweh »
Features beschriften

2 Eootures 2u raicummandeh.

Als Layer-Datei speichern.





image7.png
Q

Dotei Bearbsiten Ansicht Einfigen |Auswahl Werkzeuge Eenster Hife

Spatial analyst
DEed&

= £ Layer
O xsir_458_20040525

[m]
-

Berechnung
wert
Hoch : 855.9

GemeindegrenzetWett

Loy [Burechn B Nach bt n auswahin,

%

(x]
e EROMS

Emélcht die Auswahl von Fealures eines oder meherer Laper, basierend auf
e elativen Pasiion 2u Fealures in inem anderen Layer.

Ieh mchte:

Features auswahlen

der folgenden Layer:
S_456_20040625

|0 Gemeindegrenzsiuett
1geb_183_ 20040514

Auswahibare Layer einstelen.

DR T~ In disser Lise rur auswahibare Layer anzeigen

Qptionen. die:

volitnd enthalen sind in

den Features in diesem Laper

GemeindegrenzeWelt

o 0 Features ausgewshl)

™ Puifer anwenden auf Features in_ GemeindegrenzeWelt

Vorschau —
Die roten Features représentieren Features in _Gemeindegrenzeiv/et.

Die hervorgehobenen Features in Cyan sind ausgemahk, da sie
volitindig erthalten sind in den tten Features.

Polgane.

Ubemshmen | Schietien

[l At
3

Anzeige

zechnen ~

Auswahi von Features unter Einbeziehung der Lage von Features n einem anderen Layer

ol

A~

ol Av & Sv o

]

667344.60 255626.98 Lnbek. £

(=





image8.png
Copetbotiche:  [pommrs ]
e Ee

. —

T~ Schatten modelieren

Zeakor —
pusgezengite | %55





image9.png
REEIEY LR s AT =11

E

= £ Layer

Gemeindegrenzei

[m]

5 & Gebaudeiwett

[m]
dhmas_wett
wert
Hoch : 855.9

ol Layer-Figenschaften

x|

Defiionsabirage

Beschiftungen

Verbindungen & Bezishungen

dmen | Gusle | Aswdl | A Smboeme | Felr
Daseln
L oo et e e e ok N o
Kategorien Vaneed Fabschens
Einzelwerte OBJECTVAL = T IF EE
[l
o b e ¢ e [ etviung [ivesi [~
At e e vanes e e e 0
e ety OBIECTVAL a87
LK L ®
Zxims Zxims I
3_Klass. 3 Klass. 51 B ﬂ
4_Klass. 4_Klass. 158
5_Klass. 5_Klass. a0 ﬂ
B_Klass. B_Klass. 102
| AZufahtt A _Zufahit 3
Autobahn Autobahn 5
Ein_pust Ein_Aust 3 v

Alle Wert hizufigen| Werte iz

| Entenen | Al entrmen|  Eweitrt_~ |

0K Abtrechen | Obermehmen





image10.png
Unbenannt

rcVi

rcMap.

Dotei Bearbsiten Ansicht Einfigen Auswahl Werkzeuge Fenster Hife

DEE&E F BRX | » & M EBON QL

= & Layer

=0

=0

Strassiettoduto

— <alle 2 B Kopieren
OBIEC X ntfernen

o
=5

4 Kas: = 2 2

5 las: G4 Auf Layer zoomen

=

s

==

=

Gemeinder Features beschriften [ Feature-Auswahl aufheben

o S
O 2 © ale ausnah

Layer aus selekierten Features erstellen




image11.png
|l st + | Laper: [armzs_et

Entfernung »
Dichte.

Interpolieren zuRaster b
berflachenanalyse »

I Zelnstatst...

Nachbarschaftsstatist...
Zonale Statist..

Reklassfzeren. ..

Raster berechner

optionen,




image12.png
Features zu Raster...

Feid OBJECTVAL -
ABusgabeZelengidbe: 161533033
AusgabeRaster [FAGIS_DATANPiimarschilei

[ox ] asbeechen





image13.png
Eingabe-Raster

Redlass-Feld
[Obiectval =

Reklassifizierung

| 0id values New values &
—— i (|

= : e

| 24ass 2

i 1 Kass 2 AddEntyy
i :

L — o

Reverse NewValves | Precision.._ |

Ausgabe-Raster
[F\GIS_DATA\PrimarschideiWet\Suiass1210 =

I~ Fehlende Werte zu NoData andern (optional)




image14.png
O Gemeindegrenzetett e

[t strassenré B2 kopieren

5 et X gofermen
1 b Tbele v
Verbindungen und Beziehungen
@ Auf Layer zoomen
Seborrofstabsbereh
syiiebenen varweren

auswah

Features beschriten

2 Eeatures 2u Grafik unwandeln,

Als Layer-Datei speichern.





image15.png
Daten exportieren

Evporteren: [Ausgenahite Features =

& Koodinatensystem der Datenquelie des Layers verwenden.
 Koordinatensystem des Datersahmens vewenden

st Soplo i
PG AT PPt 53





image16.png
Primarschule230605 - ArcMap - ArcView

Datei Bearbsiten Ansicht Einfigen Auswahl Werkzeuge Eenster Hife

DEE& 8% o o | b

= & Layer

ArcToobox -
1 888 3D At Tl

[=] B3 opieren
B e 3 gferen





image17.png
Primarschule230605 - ArcMap - ArcView

DEE&| ) L@ oo [T <[l & @ DK | soataanast v | Lover [z ST
= & Layer ~
a8 b on Prima d m]
B | hape anen peRMETER | wor_suwa | wors_suwst | oan_co e e
v oo EE [ T
7 pobaen 1352700028 Zosos e aume u
Clio 2 Polygon 931.398010 141.044006 41362 41361
Strasserettingen A
Gemeindogrenaiet:
aebaudevett e
shummerdhmzs 1€ J 3 |8

O s wett atensatz 14] 413 0] Arecigen Al AusewibeDlensstze (Daus 3Ausgenshl) Gpior

“Coxt Alocation

#h suchen & Ersetzen,

1 Nach tributen auswahen.

P costbkink ]
P CosDistance Ales auswatlen
P coupah

] Auswohl atheben

2 Eudidean aloca
Auswatlunkehren

2 Eucldean Drectio
> Eucldean Distanc
> path Ditance

2 PathDitance Alc InBezishung stehende Tabelln >
2 path Ditance ac e e U
& Exracton @ Digranm erselen

Generslzstion
f Jonn

& Hycrogy

& meplston
& Lol Exporteren
& vep et

& Aussehen.
& mukvarite

il
o & ot

Tabelle dem Layout hinzufiigen

Cache neu laden

o

<
Anesige [ uele] Auswahl Favorten [Index | Suchen fooie
zeichoen ~ K () O~ A~ 2 [o]aid Jfo -] F kU A~ & S o~

Figtcer Tabele ein neues Feld hinzu | ese077.06 26002357 weter |





image18.png
Feld hinzufiigen

Neme:  [Schuhaus
Top: [ -

- Feldeigenschaften
Lange £}




image19.png
=3
Datei Bearbsiten Ansicht Einfigen
DEE& @

Edtor v M

|
I




image20.png
Op!

Aigonsin Ausdar | Zakngite|
usdtrung i e [ EE RS ~| 3
Obers 259400424

Links: GBSTITS6  Rechts | 671286431
Unter: 255250.501

|EE— |

[k Asbeechen




image21.png
Spatil fnalyst v | Layer [svasst 210 <1 4

Gerade Lie...
Dihtz.. Alokaton...
Interpolieren zu Raster »

berflachenanalyse > Korzeste Verbindung..




image22.png
Kostengewichtet

Distanz 2
Kastervaster:
Masinale Entfernung:
I™ Richtung ersteler:
¥ Alokation erteler:

AusgabeRaster

e —
—
=

oK Abbrechen





image23.png
Primarschule240605

Dotei Bearbsiten Ansicht Einfigen Auswahl Werkzeuge Fenster Hife

DSES ) “ & |[132989 =] ] & @ O R2 | spatialanabyst v | Laver [Zupimwett A m

edior ~ 2 I E = Il I
RAFZOPED VX OAS

(52 Layer

@@
am @
e
Tsie S o]
Zektnen = | R O/~ Al~ 7 [0 4 Slfe <] F & ©

schritarofe andern




